
User’s Guide to McCoy’s
RCRA Compliance CD

Before using McCoy’s RCRA Compliance CD, you must
agree to the terms of the End User License Agreement
(EULA). Distribution of this product over a computer

network without a LAN or WAN license is expressly

prohibited. If you wish to obtain information about a
LAN or WAN license for this product, e-mail McCoy and
Associates or call us at (303) 526-2674.

This guide is designed to help you become familiar with
McCoy’s RCRA Compliance CD. Many of the topics in this
guide discuss features of Adobe® Reader® that are covered
in more detail in the Adobe Reader Help, which can be
accessed from the Help menu. Other information in this
guide introduces features that are specific to the content
on this CD.

CD Overview

Contents

McCoy’s RCRA Compliance CD contains the full text of
McCoy’s RCRA Unraveled and McCoy’s RCRA Reference

in Adobe® Acrobat® electronic format. To benefit from
having both books on a single CD, it helps to understand
the nature of each book and how they work together.
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McCoy’s RCRA Unraveled captures most of EPA’s guidance
on the RCRA hazardous waste regulations. To develop
this book, we collected guidance from a variety of
sources [i.e., Federal Register preambles, EPA’s interpretive
(RCRA Online, a.k.a. RO) documents, RCRA Hotline Q&As,
EPA reports, and Office of Solid Waste and Emergency
Response (OSWER) directives]. Then, we read and distilled
that guidance into topical sections that discuss regulatory
concepts, as well as the agency’s interpretive nuances. We
also have included insights shared with us by the thousands
of hazardous waste professionals who have attended our
RCRA seminars over the years. To make this reference more
useful, we developed a keyword index that assists the
reader in finding relevant information quickly. Packed with
easy-to-read discussions, examples, and case studies, we
believe this book is the most clear and comprehensive
digest of RCRA guidance available on the planet.

McCoy’s RCRA Reference contains the complete text of
the federal hazardous waste regulations that implement
Subtitle C of RCRA: 40 CFR Parts 260–280 and 148. The
regulations within this edition are current through
November 20, 2009. Some important features set this
book apart from the Code of Federal Regulations (CFR)
published by the U.S. Government Printing Office. First,
we have worked diligently to make the text easier to read
through better formatting and by adding indentation
that allows the reader to distinguish between different
levels of paragraphs, subparagraphs, etc. Second,
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thousands of cross-references to sections of McCoy’s RCRA

Unraveled provide guidance and interpretation on the
regulations. Finally, McCoy’s RCRA Reference includes
a keyword index generated by our hazardous waste
experts, allowing the reader to locate regulations on
fundamental concepts like the “derived-from rule,” even
though such terms are never used in the text of the
regulations.

Used as a set, McCoy’s RCRA Unraveled and McCoy’s RCRA

Reference allow users to easily find both regulations and
guidance relevant to compliance topics. This powerful
combination places over 25 years of hazardous waste
information and expertise at your fingertips.

Notable Features

In developing this CD, we were not content to simply
reproduce the printed version of the two books in
electronic format because this would offer little additional
value to our customers beyond portability. Rather, our
continuing goal with this product is to take advantage
of the unique opportunities available with electronic
media. To this end, McCoy’s RCRA Compliance CD has
the following notable features:

� Complete text of McCoy’s RCRA Unraveled and McCoy’s

RCRA Reference in PDF format for broad compatibility;
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� Over 40,000 hyperlinks for easy navigation to related
information;

� Over 1,375 RCRA Online (RO) documents are included on
the CD;

� Almost 300 Federal Register notices (1995 and later) are
included on the CD;

� 18 Interactive FlowCharts (more information below);

� Hyperlinked bookmarks (i.e., electronic table of contents)
and keyword indexes;

� Formatted with larger fonts for easy on-screen reading;

� More portable format;

� All pages on the CD can be printed for reference;

� Regulations can be copied from McCoy’s RCRA Reference;

� Full text search across all content on the CD; and

� Windows and Mac compatibility.

Within each of the two books included on this CD,
you will find that references to sections of the federal
hazardous waste regulations have been hyperlinked to
take you to the text of the corresponding section within
McCoy’s RCRA Reference. Similarly, any references within
the two books to sections of McCoy’s RCRA Unraveled

have been hyperlinked to take you to that section.
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References to RO documents in McCoy’s RCRA Unraveled

have been linked to the copy of that RO document on
the CD. Finally, any reference to a 1995 or later Federal

Register citation within the two books has been
hyperlinked to a copy of that notice on the CD.

Using Interactive FlowCharts

An interactive version of each flowchart in McCoy’s RCRA

Unraveled is included on McCoy’s RCRA Compliance CD.
The interactive version asks you one question at a time,
and based on your answers guides you to a conclusion.
This step-by-step approach makes complex logic
diagrams easier to use on screen. And any guidance and
regs behind each step are hyperlinked so you can explore
and better understand the rationale for each question or
conclusion.

Entering an Interactive FlowChart is easy. When you
encounter a flowchart in McCoy’s RCRA Unraveled on
the CD, simply click on the sidebar down the left side
of the page, where you see the words Enter Interactive
FlowChart as shown in Figure 1.

Once you are in the Interactive FlowChart, use the
buttons on the lower half of the page to navigate:

� On pages with a question, click on the Yes or No button.
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� If there is a
Continue
button, click
on it when you
are ready for
additional
information.

� Keep going
until you reach
a page where
the conclusion
symbol (�)
appears at the
end of the text,
indicating you
have completed
the logic
diagram.

� If you need
to back track
through your choices, click on the Back button, which
works like a Back button in a web browser (i.e., it works
the same as the Previous View button on the Acrobat
page navigation toolbar).

� If you want to start over, click on the Start Again button.
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Figure 1: Opening an
Interactive FlowChart



� When you are finished, click on the Back To Chapter
button to go back to the full-page flowchart.

Recommendations for Using the CD

The following recommendations will help you use
McCoy’s RCRA Compliance CD more effectively.

Adobe Reader Settings

Adobe Reader includes a variety of ways to customize
the user interface. The discussion in this User’s Guide
focuses on Adobe Reader 8, although the CD content
is compatible with any version or Adobe Reader 6.0 or
higher. The interface for Adobe Reader 8 is shown in
Figure 2. If you are using a different version of Adobe
Reader, it will usually have comparable settings and
a similar user interface, but it may also have some
differences.

In order to enhance navigation for this CD, we
recommend that you make two changes. First, right-click
on any bookmark in the Navigation Pane (shown in
Figure 2) and make sure Wrap Long Bookmarks is
checked in the pop-up menu. Second, enable all of
the items on the Page Navigation toolbar. To do this,
right-click on the toolbar (also shown in Figure 2) in
Adobe Reader and choose More Tools from the popup
menu. Scroll down to the Page Navigation Toolbar
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section and enable all of the buttons on this toolbar
by checking them in the More Tools dialog shown in
Figure 3.

Locating Information

The CD is designed with several features to make it easier
to find RCRA regulations and guidance. We recommend
the following approach to finding information on this CD:

� Start with the electronic table of contents (a.k.a. Acrobat
bookmarks). The Acrobat bookmarks are the quickest way
to locate information on a broad topic or find a specific
section of the regulations.
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� Next use the keyword indexes. The indexes allow you to
locate information in the regulations or guidance on more
specific topics. You can find more information on the
indexes below.

� Use the hyperlinks within the content pages to quickly
jump to regulatory sections and guidance related to the
information on the current page.
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� Use Find and Search when trying to locate very specific
phrases or items, or when you wish to search the entire CD
for additional information on a topic. Although the temptation
is to use Find or Search as a primary means to locate
information, these functions will often return more results
than you desire. For specific examples of when to use
Find and when to use Search, see our discussion below.

Adobe Reader Quirks

Adobe Reader is one of the most widely used pieces of
software on the planet. Despite this, it has a couple
quirks that merit a mention:

� In Adobe Reader, the Navigation pane (shown in Figure 2),
where the Acrobat bookmarks reside, allows you to Page
Up and Page Down through its contents. So does the
Document pane (also shown in Figure 2). Therefore, the
action of the PgUp/PgDn keys depends on which pane is
selected. If you click on a bookmark, the focus stays in the
Navigation pane. As a result, if you then press the PgDn
key to move to the next page in the document, Adobe
Reader will actually page down in the bookmarks, which
is usually not what you are trying to do. To avoid this, you
must click somewhere within the Document pane to
select that pane before pressing PgUp/PgDn keys.

� Some of the default settings for Adobe Reader are
designed to simplify the interface. However, these settings
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also hide some of the more useful features, and they
make Adobe Reader more difficult to use for large-scale
content like McCoy’s RCRA Compliance CD. For this reason,
we suggest you follow the recommendations in the
section entitled Adobe Reader Settings above.

Note that McCoy and Associates does not have any
control over the behavior or development of Adobe
Reader. If you have problems with Adobe Reader
or suggested improvements for this software, we
recommend you contact Adobe directly through their
website at www.adobe.com.

Navigating the CD

The various means of navigating the contents of this CD
can be divided into two categories: 1) Adobe Reader
navigational controls, and 2) navigational aids built into
the content.

Adobe Reader Navigational Controls

Adobe Reader offers two main ways to navigate the content
on the CD. Figure 2 shows the Adobe Reader interface.

Bookmarks

The most obvious means of navigation is the Navigation
pane (see Figure 2), which has a Bookmarks tab (called a
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“panel” in Acrobat lingo). Acrobat bookmarks are like an
electronic table of contents for the CD. You can browse
the bookmarks for sections of interest. Any bookmark
with a + before it can be expanded to show subsections
by clicking on the + or double-clicking on the bookmark.
When you find a section of interest, click on the
bookmark and you will be taken to that section. This is
probably the quickest means of navigating to a broad
topic of interest or a particular section of the regulations.

In addition, McCoy’s RCRA Unraveled include three lists at
the end of the bookmarks: a list of case studies, a list of
figures, and a list of tables. So, if you are looking for a
particular case study, figure, or table, this may be the
fastest way to find it.

The Navigation pane has a Close button in the upper
right-hand corner as shown in Figure 2. To reopen the
Bookmarks panel, click on the Show/Hide Bookmarks
button (shown in Figure 2) along the upper left edge
of the Navigation pane.

One thing worth noting is that each RCRA Unraveled

chapter and RCRA Reference part on the CD is contained
in its own PDF file. As a result, when you click on a
hyperlink that takes you to a different chapter or part, the
bookmark list switches back to its default state. From a
user’s perspective, this simply means that any expanded
sections in the bookmarks list will collapse. Although
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we’d love this to work differently, it is currently a
technical limitation of the PDF format.

Page Navigation Controls

Three other means of navigation can be found on the
Page Navigation Toolbar shown in Figure 4. If you have
not enabled all of the buttons on this toolbar, consult
Adobe Reader Settings above for instructions on how to
do this.

On the left side of the toolbar are buttons that allow you
to navigate to the first, previous, next, and last page of
the current PDF file. Because McCoy’s RCRA Compliance CD

is divided into several PDFs, think of these buttons as a
means of navigating within the current chapter or part.

In the middle of the Page Navigation Toolbar is a control
that allows you to type in a page number and press Enter
to go to a specific page within the current PDF file. This
portion of the
toolbar also
shows the total
number of
pages in the
current PDF file.

On the right side
of the toolbar
are the Back and

2010 Edition of User’s Guide
McCoy’s RCRA Compliance CD
©2010 McCoy and Associates, Inc.
Page 13 of the User’s Guide

U
se

r’
s

G
u

id
e

Back

ForwardFirst Page

Previous Page

Last Page

Next Page Go To Page Number

Figure 4:
Page Navigation Toolbar



Forward buttons. Adobe Reader calls these Previous View
and Next View. However, these buttons work much like
the Back and Forward buttons in a web browser, allowing
you to move back and forward through the history of
views that you have navigated during your current CD
session. So, for example, suppose you were reading
guidance on a topic and clicked on a hyperlink to a
section of the regulations. You could click on the Back
button to return to the guidance. Unlike the previous two
items on this toolbar, the Back and Forward buttons work
across chapter and part boundaries.

Finally, the navigational functions described above can
also be accessed via Go To under the View menu in
Adobe Reader.

Content Navigational Aids

The CD content also has several built-in navigational aids
that can assist in finding information on specific topics.

Keyword Indexes

Both McCoy’s RCRA Unraveled and McCoy’s RCRA Reference

include a hyperlinked keyword index. These indexes are
knowledge-based, which means our regulatory experts
have gone through the material and assigned
appropriate keywords. This enables you to find
information on terms like “derived-from rule,” even
though that term never appears in the regulations.
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We believe the keyword indexes are very important to
using this CD effectively. Because of this, the Acrobat
bookmarks contain a bookmark to each of the indexes,
and beneath these bookmarks are letter bookmarks to
take you to specific letter headings within the parent
index. Once you’ve reached the letter heading, simply
page down to the topic you are seeking. If you are
already in one of the indexes, we have also provided
hyperlinked tab letters down the right side of each index
page to assist in index navigation. Once you are within
an index, this is the quickest way to get to a topic.

When To Use the Indexes

We recommend using the keyword indexes if you are
looking for information on specific topics. Use the indexes
to locate:

� Regulations implementing specific requirements. For
example, if you want to know all the regulatory sections
that implement the mixture rule, look up “mixture rule” in
the RCRA Reference Index to discover that §§261.3(a)(2)(i)
and (iv), and 261.3(b)(2)-(3) comprise the main portion of
the mixture rule. Because all index entries are hyperlinked,
you can go directly to any of these portions of the
regulations with a click of the mouse.

� Guidance on very specific topics. For example, to find
guidance on the difference between by-products and co-
products, look up the primary keyword “BY-PRODUCTS” in
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the RCRA Unraveled Index and find the secondary key
that says “Not the same as co-products.” There you will
find hyperlinked references to guidance on this issue.

Hyperlinks

McCoy’s RCRA Compliance CD includes tens of thousands
of hyperlinks within the pages of the content. When you
click on a hyperlink, it will take you to the page upon
which the linked information appears. However, it may
not change the page view or zoom options that are
currently selected. Thus, if you have zoomed in on a
particular portion of a page, clicking on a hyperlink may
maintain the zoom level and take you to the upper left-
hand portion of the page where the linked information
occurs.

For this reason, we recommend that you familiarize
yourself with the page view and zoom options that
Adobe Reader offers (discussed below).

The following items are hyperlinked throughout the CD:

� Regulatory citations to sections of the hazardous waste
regulations [e.g., §262.34(a)].

� References to sections in McCoy’s RCRA Unraveled. For
example, if you see a little book icon at the end of a
section of the regulations followed by one or more
numbers, like� 2.5.1.2, this would link to Section 2.5.1.2
in McCoy’s RCRA Unraveled.
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� References to RCRA Online (RO) documents (e.g., RO
11158), in McCoy’s RCRA Unraveled. Furthermore, the RO
documents have been captured and included on the CD
so you do not have to be online to access them.

� References to 1995 and later Federal Register (FR) notices,
like 60 FR 37975. These notices have been captured and
included on the CD so you do not have to be online to
access them.

� Web and e-mail addresses.

Finding and Searching

Sometimes, you may want to locate a particular word
or phrase on the CD. Or perhaps you wish to locate
all information on a particular topic. In this case, the
navigational aids discussed previously may not provide
much help. However,
Adobe Reader includes
two built-in features
that can be used for this
task: Find and Search.
These functions can be
accessed via the toolbar
button shown in Figure 5
or via the Edit menu in
Adobe Reader. In order
to access Search from
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Find and Search



the toolbar, click on the down arrow button to the right
of the Find box to display the menu shown in Figure 5.

Adobe Reader Find

The Find function in Adobe Reader allows you to perform
a simple text find within the current PDF file. Find will
start from the current position in the document and find
forward. However, Find has some notable limitations:

� Find locates matches only in the currently open PDF
document. Because McCoy’s RCRA Compliance CD is split
into several PDF files, Find will locate matches only in the
currently open chapter or regulatory part.

� Due to the nature of Acrobat documents, when the
find phrase is split across a page boundary (i.e., the first
portion of the phrase is on one page and the remainder
is on the next page), Find will usually miss that
occurrence.

� For similar reasons, occurrences of words that have been
hyphenated across lines may be missed.

When To Use Find

Because it is a simple text find, Find is often the easiest
way to locate a specific word or phrase in close proximity

to the current page of the document. Use Find to locate:
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� RCRA Online (RO) numbers or Federal Register references for

the current topic. For example, you are reading a section
in McCoy’s RCRA Unraveled and wish to know which RO
documents or FR sections our discussion is based upon,
but you have not encountered any RO numbers or FR
references yet. If you do a Find for the word “RO” or “FR”
it will take you to the next occurrence, which is probably
the basis for the preceding text.

� Specific words within the current topic or regulatory section.

For example, you have already located the beginning
of the Part 265, Subpart J tank standards applicable
for 90-day tanks, but want to know what secondary
containment requirements apply. You could do a Find for
“secondary containment”, and the third occurrence of this
term is at the beginning of the secondary containment
requirements.

Whenever using Find, keep in mind the limitations
detailed previously.

Adobe Reader Search

The Search function in Adobe Reader is extremely
powerful. In order to fully unleash it’s power, the PDF
file(s) must be indexed, and your Adobe Reader must
have the Search plug-in installed. We have indexed all of
the content on McCoy’s RCRA Compliance CD (including
the RO documents and FR notices), so you only need to
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ensure that
your Adobe
Reader
installation
includes
Search.

Search is more
powerful than
Find, as well as
more complex.
Search will
locate any
occurrences of
the word or
phrase within
all indexed
documents,
then rank the
documents
based on the
results.

To use Search, click on the down arrow next to the Find
box on the toolbar. Then select Open Full Reader Search
from the drop-down menu as shown in Figure 5. When
you do this, the Search dialog (Figure 6) will appear.
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To use Search,
type in a word
or phrase,
specify that
you want to
search in the
index named
RCCD.PDX,
and click the
Search button.

When the
search is
complete, a
dialog similar
to the one
shown in
Figure 7 will
appear listing
all of the
documents
on the CD that
contain search matches. Within the list, you may see up
to 6 types of listings:

� RCRA Unraveled Chapters, which will look something
like “RCRA Unraveled: Chapter 13 – Land Disposal
Restrictions”;
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� RCRA Reference Parts, which look like “PART 261 –
Identification and Listing of Hazardous Waste”

� RCRA Online Documents, such as “RO12345.PDF”;

� Federal Register notices, like “65_12345.PDF,” where the first
two digits are the Federal Register volume, and the last
five digits are the first page number in the notice; and

� Keyword index listings, either “RCRA Unraveled: Index” or
“RCRA Reference: Index.”

� Interactive FlowChart Listings, which look like “Interactive
Flowcharts.”

The default sort for the Search results is by Relevance
Ranking, so documents higher in the list have more
matches than those lower in the list. If you click on the +
sign to the left of a document in your search results, it
will expand the search results under that entry so you
can see all matches within the document as shown in
Figure 8. Then, you can click on a particular match to
display the page in the Document pane. Alternatively, if
you click on the document entry itself (rather than the +
sign before it) in the search results, it will expand the
search results under that document entry, and it also will
open the first result in the Document pane. When you
view one of the search results, the search phrase will be
highlighted on the page.
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If your search
returns too
many results,
and you want
to narrow
them down,
you can click
on the Refine
Search Results
link at the
bottom of the
Search Results
Dialog. This
will allow
you to do an
additional
search within

the previous
results.

In addition
to the basic
Search just described, Adobe Reader also has some
advanced search options, available by clicking on the
Use Advanced Search Options link at the bottom of the
Search Dialog:

� Word Stemming finds words that contain the “stem” of
the specified search word. So, if you search on “test” with
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word stemming enabled, it would find all occurrences of
test, testing, tested, tests, etc.

� Boolean searches are supported, including a proximity
option. For more information on Boolean searches and
the proximity option, consult Adobe Reader Help.

Our description of the Search function hits only the
highlights. If you plan to use this function, we highly
recommend that you take a few minutes to peruse the
information on this function in the Adobe Reader Help,
accessible from the Help menu.

When To Use Search

Although the Search function can be extremely useful,
it often results in a tremendous number of matches. For
this reason, we recommend you use Search only to locate
extremely specific words, items, or phrases across the
entire CD. Use Search to locate:

� Additional guidance on issues similar to those discussed in a

specific RO document. For example, you have obtained RO
11261 that discusses treatment of hazardous wastes in
90-day accumulation units without a permit. This RO
document provides some information, but does not
answer all of your questions, so you would like to locate
additional RO documents and guidance dealing with this
issue. You perform a Search on “11261” and find one
match in RCRA Unraveled. In the text nearby, you discover
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that RO 14618, as well as several Federal Register notices,
also discuss this issue.

� A very specific phrase used in the regulations. For example,
someone has quoted the following portion of the
regulations to you: “Used oil that is recycled includes
any used oil which is reused,” but has not given you a
regulatory citation. You perform a Search on the phrase,
or a portion of the phrase, to discover that the regulatory
citation for this phrase is §261.6(a)(4).

� All references to a particular regulatory section. For example,
you are interested in additional information on the
§265.173(a) regulatory provision requiring containers to
be closed except when adding or removing waste. You
perform a search on “265.173(a)” and locate all references
to this provision in both books.

� Information that you cannot locate otherwise. For example,
you have searched through the bookmarks and keyword
indexes for compliance information but haven’t found
anything applicable to your situation. Searching the entire
CD and reviewing the results may yield additional results.

Page View and Zoom Options

Adobe Reader offers several options and controls for
the page view and zoom. Although the CD is generally
designed to be viewed in single full-page view, we
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recommend that you
familiarize yourself with
these options and
controls to enhance
your use of the CD.

Page View Options and
Controls

Adobe Reader has a pair of Page Display control buttons,
shown in Figure 9. These buttons work as follows:

� The Single Page View button forces Adobe Reader to
display a single page at a time. Because hyperlinks within
McCoy’s RCRA Compliance CD take you to a specific page,
but not a specific place on that page, this is the view we
recommend.

� The Continuous Pages View button will allow you to scroll
from page to page with more than one page (and the
page boundary) visible on screen at the same time. If you
choose to use this view, when you click on a hyperlink,
the target section may not be visible on screen since the
link will take you to the top of the page upon which the
target section lies. This is not a problem if you are aware
you may have to scroll down the page to find the target
section, but can be disconcerting otherwise.

In addition, the View menu contains some additional
options under Page Display.
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Figure 9:
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Zoom Controls

As mentioned previously, most
of the CD content is designed
to be viewed in full-page view.
However, some tables and
figures on the CD are fairly
complex, so it was impossible to
achieve that objective for those elements. This is where
the Adobe Reader zoom controls, shown in Figure 10,
become useful.

The Zoom In and Zoom Out buttons can be used to
incrementally increase or decrease the zoom. If you want
to select a specific Zoom, you can enter a percentage in
the Zoom Level control or use the drop-down menu on
that control to specify a Zoom.

One particularly helpful Zoom tool that is not shown by
default in Adobe Reader 8 is the Marquee Zoom. You
can enable this tool by right-clicking on the toolbar, and
choosing More Tools from the pop-up menu. When you
do this, the More Tools dialog appears. If you scroll down
to Select & Zoom Toolbar and check the box next to
Marquee Zoom, this will enable the tool.

The Marquee Zoom tool works in two basic ways:

� First, you can simply move it over an area of the page
you wish to zoom in on and click. This will zoom in on
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the page in fixed increments (i.e., just like the Zoom In
button). If you hold down on the Ctrl key while doing
this, the tool will zoom out incrementally instead (i.e., just
like the Zoom Out button).

� Second, if you use the tool to drag a rectangle around
the area you wish to zoom in on, that area will fill the
Document pane of the Adobe Reader window.

Note: if you are zoomed in on a page and wish to see
the entire page, the quickest way to do this is to open
the Zoom Level drop-down menu and select Fit Page.

Printing Pages

You may print any of the pages on the CD for your own
use. A word of caution is in order, however.

One of our goals with McCoy’s RCRA Compliance CD was
to reformat the content for easier on-screen reading. As a
result, the electronic format includes around 5,900 pages
(much longer than the printed versions of these books),
plus over 1,375 RO documents and 295 FR notices.

While this allows us to enhance readability and
functionality, we must caution you that the default print
range in Adobe Reader is to print the entire document,
and some documents within the content are very long
(e.g., Part 264 is over 600 pages). Thus, it would be wise
to determine the page range you want to print and enter
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that in the Print Range section of the Print dialog box—
unless, of course, your printer holds a lot of paper!

Two easy ways are available to determine the current
page for a particular chapter or part. First, you can always
use the Go To Page control on the Adobe Reader toolbar,
which displays the page number within the current PDF
file. Alternatively, on the left side of each page header
(including the one on this page), we have also provided
the page number.

Troubleshooting

Opening the CD

Problem: The CD does not automatically run when I

place it in my CD drive. How do I start it?

Solution:

For Windows: Click on the Start Button and select Run.
Type: D:/html/index.html (where “D:” is the drive letter of
your CD drive). Click OK for additional instructions.

For Macintosh: Autorun is not supported by Mac OS X.
Instead, open START.PDF on the CD with Adobe Reader.

Problem: When Adobe Reader opens, I receive a

message that says: “You cannot currently view Adobe

PDF files from within your web browser due to a

configuration problem. Would you like Adobe Reader
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to fix the configuration?” How do I disable this

message?

Solution: This may occur when using older versions
of Adobe Reader. Upgrading to a more recent version
should eliminate this message. Alternatively, when the
message appears, you can uncheck the box that says
“Always perform this check when starting Acrobat.” Then
click on the No button. In older versions, you can also
disable the warning in the Adobe Reader preferences.
To do this, select Preferences from the Edit menu. In the
Preferences dialog, select Options in the left pane and
then uncheck Check Browser Settings When Starting
Acrobat.

Problem: I want to run the CD from a networked

drive.

Solution: In order to run the CD from a networked CD-
ROM drive, you must have a LAN or WAN license. McCoy
and Associates will provide instructions for setting up the
CD on a network with your license. You may contact us
at (303) 526-2674 or info@mccoyseminars.com.

Problem: Adobe Reader will not run properly on my

computer.

Solution: If you are having problems with Adobe Reader
running on your computer, we suggest that you consult
the Adobe Reader Support section on Adobe’s website. If
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you contact McCoy and Associates, we will do everything
we can to assist you; however, Adobe is better suited to
assist you with Adobe Reader issues.

Using the CD

Problem: When I click on a hyperlink, it does not take

me to the correct place.

Solution: Bookmarks and hyperlinks within McCoy’s RCRA

Compliance CD take you to the page upon which the
hyperlinked section appears. However, your current view
(including zoom level) is not always changed. Therefore, if
you are zoomed in on a page and click on a hyperlink, it
may be necessary to open the Zoom Level drop-down
menu and select Fit Page to see the entire page and
locate the hyperlinked material. For more information on
working with page view and zoom options, consult our
previous discussion.

If you have already followed these steps and still cannot
locate the hyperlinked material, please contact us at
(303) 526-2674 or info@mccoyseminars.com and let us
know the location of the hyperlink that you believe is
broken.

Problem: I can’t see the bookmarks (i.e., electronic

table of contents).
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Solution: To reopen the Bookmarks panel, click the Show/
Hide Bookmarks button (shown in Figure 2) along the
upper left edge of the Navigation pane.

Problem: I’ve performed a Search, but I’m not sure

how to navigate the results.

Solution: Please consult our previous discussion on the
Search function.

Problem: I am trying to copy text from RCRA

Unraveled, but it doesn’t work.

Solution: Although regulatory text may be copied from
RCRA Reference, the text of RCRA Unraveled is copyrighted
material that cannot be copied or used outside of the CD.
You may still print a copy of the page.

Contact Us

We are committed to providing you with the best
environmental compliance tools and information
available. If you have any questions or comments
regarding this CD, please contact us by phone at
(303) 526-2674 or e-mail at info@mccoyseminars.com.
Also, please visit our website at www.mccoyseminars.com
for up-to-date information regarding our seminars,
publications, and other products.
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